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About This Manual

Welcome to the Sierra Sports: Trophy Bass 2 Deluxe Installation
Guide. This booklet shows you how to get the game installed and
running, and provides a brief overview. Once you start Trophy Bass 2
Deluxe, you'll find several kinds of built-in help to answer any game
play questions you might have:

* Click the Preview button on the Main Menu for a guided tour of
the game’s main features.

* Point your mouse at a game button or control for a few moments,
and a brief “Button Help” message appears. You can turn Button
Help On or Off from the Options menu.

* Press F1 or select Help from the Help Menu to open the on-line
manual for the original Zrophy Bass 2 game. This shows you how
to get the most out of all the game features and windows. See the
What’s New Help file to learn about the features added in the
Northern Lakes Add-On pack.

* Select How To from the Main Menu or Help Menu, or right-
click the Fishing Screen’s Pro-Tip button to open your multime-

dia bass fishing guidebook.

* Left-click the Fishing screen’s Pro button to see Current Tip
videos based on the current conditions.

* For help with the World Opponent Network (won.net) with
Internet games, refer to the won.net Help Menu.

Installing and Starting the Game

Installing the Game—Windows 95

1. Start Windows 95.

2. Insert the Trophy Bass 2 Deluxe CD into the CD-ROM drive.

3. When the Install window appears, click on INSTALL and follow
the on-screen instructions. (If the Install window does not appear,
start Install by double-clicking Autorun on the Trophy Bass 2
Deluxe CD.)

Starting the Game—Windows 95

1. Start Windows 95.

2. Insert the Trophy Bass 2 Deluxe CD into the CD-ROM drive.

3- When the Autorun window appears, click on RUN to start the
game. (You can also start it from the Sierra folder by double-
clicking the game icon.)



Installing the Game—Windows 3.1

(Note: This will install Microsoft Win32s and Video for Windows to
your Windows System directory.)

If you are in Windows 3.1, exit Windows.

From the DOS prompt, type SHARE.

Start Windows 3.1.

. Insert the Trophy Bass 2 Deluxe CD into the CD-ROM drive.
From the File menu, select RUN.

In the RUN window, type d:\setup and press [Enter] (assuming d
is your CD-ROM drive name. Enter the correct name for your

CD drive).

7. Follow the on-screen instructions.
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Starting the Game—Windows 3.1

. Start Windows 3.1.

. Insert the Trophy Bass 2 Deluxe CD into the CD-ROM drive.
. Open the Sierra Program Group.

. Double-click on the Trophy Bass 2 icon to start the game.
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Additional Setup Help

During installation, TEST SYSTEM checks to make sure your
computer can run the game. If you still have trouble installing or
starting Trophy Bass 2 Deluxe, first check the Setup Help file. To do
this, start Setup and then click SUPPORT, and then CONTENTS
to find help on your specific system component or problem.
Additional information may be found in the Trophy Bass 2 Deluxe
README file.

WIN95 users with Internet access can select SIERRA WEBPAGE
from Setup to access customer support, frequently asked questions,
and possible updates for Trophy Bass 2 Deluxe.

Win 95 Multi-Player Game Setup

Under Windows 95, Traphy Bass 2 Deluxe supports three “remote”
multiplayer game options. To use any of these options, each player
must have the Trophy Bass 2 Deluxe CD installed and in the CD
drive, as well as the appropriate hardware:

Modem Play: Both players need to have a 14.4 or better modem
configured for Windows 95 and connected to an open phone line.

Network Play: All players need to be connected to the same local
area network (LAN), and on the same fileserver and subnet.

Internet Play: Each player needs an Internet browser that runs under
Windows 95, and Internet access via modem or network.



Trophy Bass 2 Deluxe Overview

This section briefly introduces the game’s main features. See the on-
line Preview and Help in the game for complete information.

Trophy Bass 2 Deluxe is a highly accurate bass fishing simulation
based on real lakes, real lake conditions, and real bass behavior. To
succeed, you will need to consider the weather, season, water
conditions, and many other factors that affect how real bass act.
What you learn playing Trophy Bass 2 Deluxe, seeing the Pro video
tips, and reading the “How To” multimedia bass fishing reference
will be equally useful on real fishing trips...and vice versa.

If you have already mastered the basic “How-To’s” of bass fishing,
you’ll find plenty of new challenge in playing at the Medium and
Hard skill levels, or Tournament fishing against the computer. The
ultimate challenge is Tournament fishing against other expert anglers
over a modem, a local area network, or on the Internet.

Getting Started

If you're new to Trophy Bass, you can select Preview on the Main
Menu for a guided tour of the game.

To start learning how to fish right away, select Single Player, then
Fishing Trip, and then “Quick Fish.” This gets you out on the lake
with everything set up nice and easy. See the Help menu for quick
info on How To Cast, Fighting Fish, and other topics.

To explore different skill levels, lakes, and fishing conditions, choose
the Single Player Fishing Trip option “Start a New Fishing Trip” and
select the settings you want.

When you’re ready for more of a challenge, Single-Player Tourna-
ments and Careers pit you against simulated Pro opponents and
tougher conditions. You'll have to have a pretty good grasp of the
game’s fishing controls, bass behavior, and lure selection to be
competitive here. Try the Pro Tips or How To for hints.

The greatest test of your skills is Multi-Player games with human
opponents over a modem, network, or the World Opponent Network
(won.net) Internet server. Tournaments are fast and frenzied bass-
busting contests where every second counts. With the Deluxe upgrade,
you can also play tournaments for species other than bass with other
TB2 Deluxe or Northern Lakes owners. Weigh in with lots of big fish,
and the bragging rights are all yours. . .at least until the next game starts.



Fishing Screen Quick Reference

Cast Controls

Pro Autocast Cast Lure Cast
Tips Aim Map Cast Meter Select Select

roll Motor Drag Rod/Line

Scent ]
Controls Setting Select

Livewell

Reel Controls

Rod Position Reel Meter Line Out

Line Tension Meter Drag Setting Lure Depth

Keyboard Controls

Felpjt e nbba e s Lt icidite el o, F1

ReeltSpeed it Su Sy Goai S ]:829)
Increase/Decreaseiragte.l i 0 Siis i +/-

Steer Boat, Troll Motor.........o...... o i Arrow Keys
Highlight Next, Previous Option .................. Tab, Shift-Tab
Select Highlighted Option........cccccceevuiinncnne. Enter

Pause Game (Single-Player only) ................... 1P

Open Chat (Multi-Player only) .................... Any letter key
Send Message il o sE Lol B St Enter
Closei@hatue mesl b v i i Esc




Technical Support

Automated Technical Support Line—USA: 1-425-644-4343

Sierra On-Line offers a 24-hour Automated Technical Support line with re-
corded answers to the most frequently asked technical questions. To access this
service, call (425) 644-4343, and follow the recorded instructions to find your
specific topic and resolve the issue. If this fails to solve your problem, you may
still write, or fax us with your questions, or contact us via our Web site.

North America
Sierra On-Line Main: (425) 644-4343

Technical Support Monday-Friday, 10:00 a.m.—6:45 p.m. PST
P.O. Box 85006 Fax: (425) 644-7697

Bellevue, WA 98015-8506 htep://www.sierra.com

support@sierra.com

Automated Technical Support Line—United Kingdom: (0118) 920-9111
Cendant Software International Limited offers a 24-hour Automated Technical
Support line with recorded answers to the most frequently asked technical
questions. To access this service, call (0118) 920-9111, and follow the recorded
instructions to find your specific topic and resolve the issue. If this fails to solve
your problem, you may still write, or fax us with your questions, or contact us
via our Internet or CompuServe sites.

United Kingdom

Cendant Software International Ltd.  Phone: (0118) 920-9111

2 Beacontree Plaza,
Gillette Way, Fax: (0118) 987-5603
Reading, Berkshire http://www.sierra-online.co.uk

RG2 0BS United Kingdom
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Monday—Friday, 9:00 a.m.—5:00 p.m.

France

Cendant Software International Ltd.

Parc Tertiaire de Meudon
Immeuble “Le Newton”

25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex

France

Germany

Cendant Software International Ltd.

Robert-Bosh-Str. 32
D-63303 Dreieich
Deutschland

Spain

Cendant Software International Ltd.

Avenida de Burgos 9
1°-OF2

28036 Madrid
Spain

Italy: Contattare il vostro distribotore.

Téléphone: 01-46-01-46-50
Lundi au Vendredi de 9h 4 19h
Fax: 01-46-30-00-65

htep:/fwww.sierra.fr

Tel: (0) 6103-99-40-40

Montag bis Freitag von 9-19Uhr
Fax: (0) 6103-99-40-35
Mailbox: (0) 6103-99-40-35

http://www.sierra.de

Teléfono: (01) 383-2623
Lunes a Viernes de 9h30 a 14h
y de 15h a 18h30

Fax: (01) 381-2437
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Customer Service Support and Sales

United States

Sierra Direct U.S.A. Sales Phone: (800) 757-7707
7100 W. Center Rd International Sales: (425) 746-5771
Suite 301 Hours: Monday-Saturday 7 a.m. to 11 p.m. CST
Omaha, NE 68106 Sundays 8 a.m.to 9 p.m. CST
FAX: (402) 393-3224
United Kingdom
Cendant Software
International Ltd. Main: (0118) 920-9111
2 Beacontree Plaza, Monday-Friday, 9:00 a.m.-5:00 p.m.
Gillette Way, Fax: (0118) 987-5603
Reading, Berkshire Disk/CD replacements in the U.K.
RG2 0BS United Kingdom are £6.00, or £7.00 outside the UK.
Add “ATTN.: Returns.”
France
Cendant Software
International Ltd. Phone: (01) 46-01-48-50
Parc Tertiaire de Meudon Lundi au Vendredi de 9h 4 19h
Immeuble “Le Newton” Fax: (01) 46-30-00-65

25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex

France

12

Germany

Cendant Software

International Ltd. Tel: (0) 6103-99-40-40
Robert-Bosh-Str. 32 Montag bis Freitag von 9h—19Uhr
D-63303 Dreicich Fax: (0) 6103-99-40-35

Germany

On-Line Sales

CompuServe United Kingdom: GO UKSIERRA
CompuServe France: GO FRSIERRA

CompuServe Germany: GO DESIERRA

Internet USA: http://www.sierra.com

Internet United Kingdom: http://www.sierra-online.co.uk
Internet France: http://www.sierra.fr

Internet Germany: http://www.sierra.de
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Sierra Warranty and Legal Information

YOU ARE ENTITLED TO USE THIS PRODUCT FOR YOUR OWN USE, BUT MAY NOT COPY,
REPRODUCE, TRANSLATE, PUBLICLY PERFORM, DISPLAY, OR REDUCE TO ANY
ELECTRONIC MEDIUM OR MACHINE- READABLE FORM, REPRODUCTIONS OF THE
SOFTWARE OR MANUAL TO OTHER PARTIES IN ANY WAY, NOR SELL, RENT OR LEASE THE
PRODUCT TO OTHERS WITHOUT PRIOR WRITTEN PERMISSION OF SIERRA. YOU MAY USE
ONE COPY OF THE PRODUCT ON A SINGLE COMPUTER. YOU MAY NOT NETWORK THE
PRODUCT OR OTHERWISE INSTALL IT OR USE IT ON MORE THAN ONE COMPUTER AT THE
SAME TIME.

UNAUTHORIZED REPRESENTATIONS: SIERRA WARRANTS ONLY THAT THE PROGRAM WILL
PERFORM AS DESCRIBED IN THE USER DOCUMENTATION. NO OTHER ADVERTISING,
DESCRIPTION, OR REPRESENTATION, WHETHER MADE BY A SIERRA DEALER, DISTRIBU-
TOR, AGENT, OR EMPLOYEE, SHALL BE BINDING UPON SIERRA OR SHALL CHANGE THE
TERMS OF THIS WARRANTY.

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, SIERRA MAKES NO
WARRANTY, EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY
WARRANTY THAT THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED
WARRANTY OF MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION
OF THIS LIMITED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFI-
CALLY DISCLAIMED. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDEN-
TAL, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE
OF THE POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE
RESPONSIBLE OR LIABLE FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR
COSTS INCURRED AS A RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR
FROM ANY OTHER CAUSE EXCEPT THE ACTUAL COST OF THE PRODUCT. IN NO EVENT
SHALL SIERRA’S LIABILITY EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

This End User License Agreement grants you a limited license to use the Redistributable Code
licensed to Sierra On Line, Inc. by Microsoft Corporation, Inc. together with Microsoft
operating system products. All intellectual property rights in Microsoft's Redistributable Code

contained in this product belong exclusively to Microsoft Corporation, Inc.
© 1998 Sierra On-Line, Inc.
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Sierra Sports: Trophy Rivers™

From the makers of the acclaimed best-seller Trophy Bass comes the
new champion of fishing games, Trophy Rivers. Cast flies or lures as
you drift-fish five of North America’s best trout, salmon, and steel-
head streams—over 200 miles of prime water to explore! Realistic
river currents, insect hatches, migration patterns and species charac-
teristics bring these rivers to life. An extensive How-To multimedia
guidebook and over 100 video pro-tips offer expert info to novices
and veterans alike. Don’t miss the boat! Trophy Rivers from Sierra is
the new breakthrough in cyber-angling. Get yours today!

Call 1-800-757-7707 or order from the web site at:

www.sierrasports.com/fishing.html
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Fishing Screen Quick Reference
Casting

Pro Autocast Cast Lure Cast
Tips Aim Map Cast  Meter Select Select

Livewell Scent  Troll Motor Drag Rod/Line
Controls Setting Select

Fighting Fish

Rod Position Reel Meter Line Out

Line Tension Meter Drag Setting Lure Depth

Install Instructions Inside

Sonis

Call 1-800-757-7707 or visit your local retailer today. See our web site at www.sierrasports.com

©1998 Sierra On-Line Inc. ® and ™ designate trademarks of, or licensed to, Sierra On-Line, Inc., Bellevue, WA 98007. All rights reserved.



